:BEnD-TEl::Z
SOF TWRRE

SDS/2 Design Transfer Software



©2021 Bend-Tech LLC

All rights reserved. The information in this manual is subject to change without notice.
Bend-Tech LLC strives to produce the most complete and accurate information regarding its
products. We are constantly working to improve and advance our products to improve product
performance, user satisfaction and experience. Bend-Tech LLC assumes no responsibility for
errors or omissions regarding this manual. Bend-Tech LLC assumes no liability for damages
resulting from the use of the information contained in this publication.



Bend-Tech Software

SDS2
Design Transfer Software
Revision 4

English
Original Instructions

November 2021

Bend-Tech LLC
729 Prospect Ave.
Osceola, WI 54020 USA

(651) 257-8715
www.bend-tech.com
support@bend-tech.com



Revision 4

November 2021
Contents
1. Introduction . .................... 5
2. Computer Requirements .. ......... 5
2.1 Supported Versions . .......... 5
3. Installation ...................... 5
3.1 Installation Process. . .......... 5
4. Installation Troubleshooting . . ....... 6
5. Opening the Application ........... 6
6.Userlinterface. . .................. 6
6.1PartLog .................... 6
6.2 Mouse Actions ............... 6
7. Exporting Process .. .............. 7
8. Transferring to Bend-Tech Software. . . 7
8.1 Importing the Transfer File . . . ... 7
8.2SavingtheFile ............... 8
9.S8ettings . ......... ... ... ... 8
9.1 Directory Settings............. 8
9.2 Write Errors as Geometry. . ..... 8
9.3 Straight Parts Only . . . ......... 8
9.4 Write PieceMark ............. 8
9.5 Write Parts to Individual Files. ... 8
9.6 Display Settings . ............. 8
9.7 Software Version. . .. .......... 8
10. Part WarningLogs . . ............. 9
1. Failurelogs.................... 9
12. Progress Bar Notifications . . ... ... 10
13. Progress BarErrors . .. ........... 11
14. Troubleshooting . . . .............. 11
14.1 Install Microsoft Visual C++
Redistributable Package. ... ....... 11

14.2 Verify/Install .Net Package 4.5 . .11
15. Manually Installing the Transfer Button12

15.1 Installation for 2021

......... 12

15.2 Installation for 2020 or Earlier. . 18

Bend-Tech Software

Design Transfer Software: SDS/2



November 2021 Revision 4

1. Introduction

Bend-Tech Design Transfer software allows the User to seamlessly transfer part design data
from SDS/2 to Bend-Tech. Design Transfer works by extracting data from the SDS/2 design
program and remodeling solids. Bend-Tech Design Transfer remodeling feature generates
high-fidelity geometry, and facilitates improvements to the transfer workflow that benefit the
fabricator.

2. Computer Requirements

The user will need the required supporting software in order to run Bend-Tech Design Transfer.

2.1 Supported Versions
As of November 2021 the only supported versions are 2018.08, 2020.04, and 2021.

3. Installation

The user will be required to install Bend-Tech Design Transfer software before beginning use.

The software should be installed to the computer running SDS/2. This may not be the Dragon
computer.

3.1 Installation Process

On the computer where SDS/2 is installed, double click on the Bend-Tech icon labeled “Install.”
This will begin the SDS/2 installation procedure.

Click “Yes” to allow the software to make changes to the computer.

The Bend-Tech Design Transfer Setup will begin. Click through the series of installation
popups.

In the SDS/2 Toolbar Configuration popup, choose the configuration(s) you wish to add the
Design Transfer button to. Do this by highlighting the configuration and clicking “Add”. If you
do not know which configuration(s) you use, it is most likely MODELING-2020.

Choose next.

Continue to click through the installation popups until installation is complete.
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4. Installation Troubleshooting

The key to installing Bend-Tech SDS/2 Design Transfer is ensuring the user has the latest
version of SDS/2 installed on the computer. If the latest version is not installed, the installer will
prompt the User to update the software.

5. Opening the Application

With a project opened in SDS/2, at the top of the Detailing interface, choose the Bend-Tech
Transfer icon.

In the part display interface, left click and hold, then drag the window to select the parts that

will be exported to Bend-Tech. With the parts selected, click ENTER. A Bend-Tech Design
Transfer interface will open.

If SDS/2 is installed on a server, the Design Transfer button may not appear in the software
after installation. To manually install the Transfer Button see section 15.

6. User Interface

The parts that were highlighted in the SDS/2 Detailing interface will be shown in the Bend-Tech
Design Transfer parts display.

6.1 Part Log

On the right-hand side of the interface, the Design Transfer software will display a Log of all
the parts the Design Transfer Software imported from SDS/2.

Success - Parts that were successfully imported will be displayed in green. These are parts
Bend-Tech software will recognize such as tube and pipe.

Failure - Parts that were not successfully imported will be displayed in red. These are parts that

Bend-Tech does not recognize such as I-beam or fasteners.

6.2 Mouse Actions

Click and hold the scroll wheel, then drag the mouse to move the assembly.

Right click and hold, then move the mouse to rotate the parts.

Bend-Tech Software Design Transfer Software: SDS/2 6



November 2021 Revision 4

7. Exporting Process

Select Transfer Tool button in SDS/2 Ul

Select the items to export to the Transfer Tool

Click ENTER or right click and select OK

Warnings appear in yellow in the Data Grid. Warning parts require attention from the User
to resolve. If the part seems OK, you may hit ‘Ignore’ with the warning part(s) selected and
they will change to a ‘Success’.

Fixable parts can be isolated with the ‘Fix’ filter.

Error Parts are highlighted Red and will not save.

Click SAVE. The software will save all parts under the ‘Success’ filter as an .enc file, or

if ‘Write Parts to Individual Files’ was checked in settings all parts will be saved to the
selected directory.

BN =

No o

At the top left of the Bend-Tech Design Transfer interface, choose SAVE. This will export the
parts/assembly as a file that can be imported to Bend-Tech software.

8. Transferring to Bend-Tech Software

8.1 Importing the Transfer File

After exporting the file as an .enc file. Open the Bend-Tech software and click IMPORT from
the Main Task Menu. Select the .enc file and click OPEN.

This will load the part(s) into Bend-Tech’s auto importer. Ensure any Temporary Material

added by the import are made permanent. Go to the Material Library. Uncheck the Temporary
Material checkbox for each imported material, and click SAVE.

Important

Manual Import options and tools are not available for transfer files.

Note

Transfer files can be quite large and can take a while to load.
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8.2 Saving the File

Once the parts have been imported into Bend-Tech, they can be saved as nested projects.
Select the parts from the import list and click NEST PART. Ensure that the selected parts use
the same material size. This will load the selected parts into a new nesting project. Create a
new nesting project for each material type. With the nesting project open, click SAVE or go to
FILE > SAVE AS. Name the project and save it in an appropriate location.

9. Settings

Open the settings by clicking on the Settings button at the top left of the interface.

9.1 Directory Settings

The Directory is the default directory parts are saved to when you click Save. You may set this
by clicking the Set button and navigating to the folder you want, and then clicking OK.
Checking Open Directory on Save will open a file browser in the directory on a successful
save.

9.2 Write Errors as Geometry

When an Warning/Error occurs the geometry of the part will be saved in the file. A part will not
be created from this, but it will be transferred.

9.3 Straight Parts Only

Bends/Elbows will be thrown out completely, only straight sections will be processed. If you
change this setting and click Save, it will prompt to re-analyze the data.

9.4 Write Piece Mark

Writing the Piece Mark will add the Piece Mark to each Part Name as a suffix.
i.e. - Member HRO1 with Material m001 m001 will now be HR0O1_mO001. Without this checked,
it will just be m001.

9.5 Write Parts to Individual Files
Parts can be written to individual files within a folder instead of being saved as a full assembly.

9.6 Display Settings

Under Part Visualization and Background Visualization are settings associated with the display.
The Opaque<->Transparent slider sets the opacity of parts.

9.7 Software Version
In the lower right-hand corner of the settings window above Save is the Software Version.
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10. Part Warning Logs

A Part Warning indicates there was a hole or solid that could not be rendered properly during
the Design Transfer process.

Part Warning Log Definition

Could Not Generate Hole Model If there is an issue generating a hole,
the software will display a Could Not
Generate Hole Model part warning.
This indicates the hole may be of an
invalid type. Valid types of holes are:

+ Standard Round

* Oversized Round

* Vent Drain

* Short Slot

* Long Slot

* User Slot 1

* User Slot 2

Other types of holes will not get
processed.

Could Not Generate Solid Model If there is an issue generating a
smooth solid model the software will
display a Could Not Generate Solid
Model part warning. This is a non-fatal
issue, but it may result in something
unwanted.

11. Failure Logs

A part failure log indicates there is an error in the geometry of the part, an error in the design or
the software did not recognize the part as a solid.

Part Warning Log Definition
There was an error retrieving the The software will display this error if
profile the part has an unsupported profile or

if there was an issue with the profile.
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There was an error creating the
centerline

An error creating the centerline part
failure typically occurs when importing
a part made with Bend on Line/Bend
on Radius, or a bend which only
changes the model and does not
have parts split between straights and
elbows. Currently, Bend on Line and
Bend on Radius are unsupported.

Unable to generate solid model

Occurs when there is a failure to
create the solid model.

Unable to generate cut model

Occurs when there is a failure in
Boolean cutting operations.

12. Progress Bar Notifications

Progress Bar Notifications inform the User regarding progress of software operations.

Progress Bar Notifications

Definition

Waiting to receive input

Design Transfer is waiting for the
SDS/2 Parametric to transfer data. If
many parts are selected, this process
could take a while.

Importing Data

Design Transfer is reading and parsing
the data transferred from the SDS/2
Parametric.

Input data contains no parts

The SDS/2 Parametric has transferred
data, but no parts are contained within
the data.

Analyzing

Data has been parsed, now consulting
the data to create parts.

Creating Parts

Data analysis has finished, finalizing
parts so the user can see log
information and the solid model
representations.

Bend-Tech Software Design Transfer Software: SDS/2
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13. Progress Bar Errors

In some cases, Design Transfer progress will encounter an error. The Progress Bar will display
the error for the User.

Progress Bar Errors Definition
There was an error while analyzing the Parts were transferred via the
data Parametric, but some error occurred

while analyzing those parts and
yielded no results.

There was an error with the imported Occurs when the Parametric data is
data not in the correct format. This can
occur if the Parametric and Design
Transfer versions are out of sync.

14. Troubleshooting

In the event your Design Transfer software isn’t working properly, follow these steps.

14.1 Install Microsoft Visual C++ Redistributable Package

Go to Microsoft’s Latest Supported Visual C++ Downloads page and download the x64:
vc_redist.x64.exe under Visual Studio 2015, 2017 and 2019. Close all applications, run the
installer and restart your computer.

14.2 Verify/install .Net Package 4.5

Verify the version of .Net your computer has installed is up to 4.5. If you don’t have version
4.5, you can download the package from Microsoft here.
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15. Manually Installing the Transfer Button

15.1 Installation for 2021
1. Select Utilities in the main window of SDS/2.

2 [Hi : SAP 52 BOOST PLATFORM_JOB test

SDS2

8 SAP 52 BOOST PLATFORM_FAB D ETAI Ll N G

[& - Default Repository

3 | J | & ®
Analytics II =
Shapes User and Site Member Update Customize Parametric Verify and Fix
Properties Options Edit Attributes Interface Modeling
Project Settings
[Q Ssearch
Reports . X
Utility Functions.
Import
Job Repositories
Export

Change File Sizes

_ oo

General >
Change Options >
Copy >
Copy Job to Global >
Copy Global to Job >
Rename >
Replace >
Merge >
Delete >

Y Plugins Manager
8 il!l'l'l'l'l Part Libraries Manager

Joist Manufacturers Manager

@SDS2 >

A NEMETSGHEK COMPANY

2. Select Customize Interface.

2 [Hi - SAP 52 BOOST PLATFORM_JOB test

SDS2
£ . SAP 52 BOOST PLATFORM_FAB D ETAI Ll N G

[& : Default Repository

I VA ® | R
Analytics II == \\
Shapes User and Site Member Update Customize Parametric -
Properties Options Edit Attributes: Interface Modeling Verify and Fix
Project Settings
[Q search ‘

Reporis

Utility Functions.
Import

Job Repositories
(B Change File Sizes
Utilities Convert Jobs

General >

Change Options >

Copy >

Copy Job to Global >

Copy Global to Job >

Rename >

Replace >

Merge >

Delete >

‘ Plugins Manager
@ TII'II'I'! Part Libraries Manager

Joist Manufacturers Manager

@SDS2 >

A NEMETSCHEK COMPANY
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3. Select the role on the left you would like to add the button to. We are adding to

Detailer(Modeling).

B Customize Interface - SAP 52 BOOST PLATFORM_JOB test SAP 52 BOOST PLATFORM_FAB - x
Available roles Current role configuration: Default
Connection Designer (Modeling)
Detailer (Modeling) @mfurmatmn
Detailer (AssemblyEditor) Role name:
Detailer (EVUDetailing) = aller
Drafter (Modeling) Enyironment: Modeling ~ Launcher Manager...
Estimator (Modeling)
Fabricator (Madeling) Ribbon configuration: Modeling_Detailer Edit...
aﬂ;?:le[har\:::::;:lgj Keyboard configuration: Modeling_Detailer Edit...
Site Planner (Modeling) Shortcut menu Modeling_Detailer [E] Edit...
configuration:
; Remove
Save As... Cancel Help
B Customize Interface - SAP 52 BOOST PLATFORM_JOB test SAP 52 BOOST PLATFORM_FAB - x
Available roles Current role configuration: Default
Connection Designer (Modeling)
Detailer (Modeling) Role infermation
Detailer (AssemblyEditor) §
Detailer (EVUDetailing) (= Detailer
Drafter (Modeling) Enyirenment: ‘Modahng V| ILaunchar Manager...l
Estimater (Modeling)
Fabricator (Madeling) Ribbon configuration: Modeling_Detailer Edit...
Fh{ﬂ;?;‘lvezhtﬂl\:;:::;)sl Keyboard configuration: Modeling Detailer B Edit..
Site Planner (Modeling) Shortcut menu IModeling_Detailer & Edit...
configuration:
; Remove
Save As... Cancel Help

5. Click Add.

Add Edit

Reports Modeling selections

Delete

Launcher manager - 4P 32 BOOST PLATFORM_JOB test SAP 5...

Close Help

>

Bend-Tech Software
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6. Fill out each field as follows:
+ Button text - DesignTransfer
* Hover text - DesignTransfer

 Script - Navigate to the folder Design Transfer is installed to (default: C:/Program Files/
Bend-Tech DesignTransfer) and go into the Script folder. Select DesignTransfer.py

« Small Icon - Navigate to the folder Design Transfer is installed to, in the Script folder.
Select Icon2.png.

« Large Icon - Navigate to the folder Design Transfer is installed to, in the Script folder.
Select Icon1.png.

Launcher edit - SAP 52 BOOST PLATFORM_JOB test 5., X
Button text
Hower text DesignTransfer
Script Z:/Prograrn Files/Bend-Tech Desi
Small icon C:/Prograrmn Files/Bend-Tech Desi
Large icon C:/Program Files/Bend-Tech Desi
Cancel Feset Help

7. Hit OK, then Close. You should be back to the Customize Interface window. Select Edit
next to the Ribbon Configuration.

B Customize Interface - SAP 52 BOOST PLATFORM_JOB test SAP 52 BOOST PLATFORM_FAB - O X

Available roles
Connection Designer (Modeling)

Current role configuration: Default

Role information

Detailer (AssemblyEditar] -

Detailer EEVUDetaiylring] : Role pame:

Drafter (Modeling) Enyironment: Modeling ~ Launcher Manager...
Estimator (Modeling)

Fabricator (Modeling) Ribbon configuration: Medeling_Detailer I Edit... I
Fh{d;?:;lue[h;r\::::!;? Keyboard configuration: Modeling_Detailer Edit...

Site Planner (Modeling) SrirtimarT ) Edit...

configuration:

L.Add || Remoye

Save As... Cancel Help
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8. Next to Page, select whichever menu you would like to add the button to. We are adding to

Tools.

® Wodeling Ribbon Edito
File

Layout  Members  Material ~ Drawings ~ Tools  Display  Import/Export

Reports

Ze. BERIBEE AFAL

Selection

v|+

+ '@ Save Area

+ @ Clear Mode Stack
+ @Mmde Return

+ 9 Exit

+ E“z’ Next Erection View

— 4 ¥ [?]Create RFI

asure ~ Reference Objects Notes Search and Change Scripts ~
‘«

Menu item search: [ [enter search text] | Page: | Tools:

Menu item group:  File ¥ Section: RFI

v +

-
QN

> &

- Alttributes Tools

+ ¥

¥

Page properties

Title:

oo

Cranes ~ Bend-Tech~
»

Tools

Section properties

Title:

Rows

Columns

Item properties
Name:

Row span:

RFI
v showtitle

2

W

2 -
Add Drawer

1

Column span: | 1

Display

Image:
Image size:

Drawer type:

D label
image
® both

Small >

Recent item

9. Add a new Section.

® Hodeling
File

asure ~ Reference Objects Notes Search and Change Scripts
‘«

Menu item search: [ [enter search tex(] | Page:  Tools

Menu item group:  File ¥ Section: RFI

— 4 4 [7]Create RFI
+ @ Clear Mode Stack

+ @Mode Retumn
+ € Exit

+ &m Next Erection View

Layout Members Material Drawings Tools Display Impor/Export Reports

e BB FgE > %A

=

Selection

“m'
‘Q‘V

- Attributes

+ <+
¥

D w
®

Tools

Page properties
Title:
Section properties

Title:

Rows:

Columns

Item properties
Name:
Row span:
Column span

Display

Image:
Image size:

Drawer type:

£

Cranes ~ Bend-Tech ~
»

Tools

RFI

v show title

2 =

2 <
Add Drawer

1
1
label
image
® both
Choose
Small i

Recent item
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10.Rename the Section Bend-Tech.

® Modeling Ribbon Editor (Modeling_Detailer) - SDS2 2021 Detailing - SAP 52 BOOST PLATFORM JOB test SAP 52 BOOST PLATFORM_FAB
File

Layout  Members  Material ~ Drawings ~ Tools  Display  Import/Export  Reports

@ t@-‘;% - ﬁ; :f

e [T At AL b PP, Corrinte

Menu item search: [[enter search texi] | Page:  Tools v+ - + ¥ Page properties
Menu ftem group: ~ File ¥ Section® Section 12 v+ - i v Title:
)

12 Save Area Section properties
+ [#]Create RFI
+ @ Clear Mode Stack Tite:
+ @Mode Retumn
+ ’E Exit Rows
+ €5 Next Erection View

Golumns

Item properties
Name:
Row span:
Column span

Display

Image:
Image size:

Drawer type:

Section 12

v showtitle

2

W

2 -
Add Drawer

1
1

label
image
® both

Choose
Small >

Recent item

11. Under Menu item group, select Parametric Launchers.

@ Modeling Ribbon Editor (Modeling_Detailer) - SD52 2021 Detailing - SAP 52 BOOST PLATFORNM_IOB test SAP 52 BOOST PLATFORM_FAB
File

Layout Members Material Drawings Tools Display Import/Export Reports

A-fe BRI ER- 4L a

. [T P, P PN, Lorrinte Lalnntinn PO

1

Menu item search: | [enter search text] | Page:  Tools ¥ % = & 4 Pageproperties
Menu item group: | Parametric Launchers ¥ Section: Bend-Tech v + - o~ v Title:

+ BB DesignTransfer Section properties

Title:

Rows:

Columns:

ltem properties
Name:
Row span:

Column span:
Display:

Image:
Image size:

Drawer type:

o & 1

S Frann

Bend-Tech

v show title
1 =
1 =

Add Drawer

1
1
label
image
® both
Choose
Small 2

Recent item
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12.Click the + next to DesignTransfer.

® Modeling Ribbon Editor (Modeling_Detailer) - SDS2 2021 Detailing - SAP 52 BOOST PLATFORM JOB test SAP 52 BOOST PLATFORM_FAB
File

Layout  Members  Material ~ Drawings ~ Tools  Display  Import/Export  Reports

A -5 poR g

A
"..{f@l

+ B DesignTransfer Section properties

Title:

Rows

Columns

Item properties
Name:
Row span:
Column span

Display

Image:
Image size:

Drawer type:

e TSN, PPN, . Salnntinn P
‘«
Menu item search: [[enter search texi] | Page:  Tools v+ - + ¥ Page properties
Menu item group:  Parametric Launchers ¥ Section: Bend-Tech v + - ol ¥ Title:

e Crana ™

Bend-Tech

v showtitle
1 s
1 =

Add Drawer

1
1

label
image
® both

Small >

Recent item

13.1f the interface looks similar to the one shown here, go to File > Save, then File > Quit. Click

OK.

@ Modeling Ribbon Editor (Modeling_Detailer) - SD52 2021 Detailing - SAP 52 BOOST PLATFORNM_IOE test SAP 52 BOOST PLATFORM_FAR
File

Layout Members Material Drawings Tools Display Import/Export Reports

A -re B REREEw 0 %a

PPN Serinte Salnctinn

4

Menu item search: |[eme| search text] ‘ Page Tools ~ + - e 4 Page properties

Menu item group: ~ Parametric Launchers ¥ Section: Bend-Tech v+ - S ¢ Title:

Section properties
[]+ ] Title:

Rows:

Columns

Itemn properties

Name
Row span

Column span:
Display:

Image:

Image size:

Drawer type:

Tools

Bend-Tech

V' show title

1

(D

1

o

Add Drawer

DesignTransfer

1 =

1 =
Iabel

image
) both

Choose

Small 2

Recent item

Your toolbar should now have the DesignTransfer button on it.
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15.2 Installation for 2020 or Earlier

1. Open the Modeling window in SDS/2.
2. Go to Options > Toolbar Confinguration.

B_' Meodeling - 5D5/2 2020 Detailing -- +2020.04 (2) DESKTOP-AOLKBLM/20282
File Edit View Mavigate Model Locate Process Reports  Utility Interface  Options  Help

Select ltems Job Options

+y X Hﬂ Fabricator Options
A ) Default
/ ~ ’ Cencrete Options

ﬁ User and 5ite Options

IS
®

‘%Toolbar Configuration

Keyboard Configuration
@ Mode Configuration

@ Shortcut Menu Cenfiguration

ALeE

\'@ Lead Cenfiguration
g Save Configuration...

Help

L
et

3. Click on Launcher Manager.

File Edit View Mavigate Model Locate Process Reports Utility Interface Options Help

Elevation:

_ -21-89/16

o =1 I §
A elE Y &l b A S 2K

g’ Command Group: | File earch:|

[EEE Save Area iar:: Save Area
% Create RFI (Rilr:leate Create RFI

Clr Mode Stack ClrMode

Stack Clear Mode Stack

Meode Return Mode

Return Mode Return

Exit
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4. Click Add.

Add Edit

Delete

csi Reports Modeling selections

I Close I

Launcher manager -- v2020.04 (2) DESKTOP-ACLKBLM/ /20288 X

Help

5. Next to Script, click the dialog button.

a Launcher edit -- v2020.04 (2) DESKTOP-AOQLKBLM/Z... X .
P2 Button text |Design Transfer |
B9 Hover text |De5ign Transfer |
Script | 1
Small icon | |
Large icon | |
[] Update installed icon and script files
| IT' Cancel Reset Help L
Add || Edit || Delete || _Close || Help

6. Navigate to the folder where the Bend-Tech Design Transfer software is installed. This will

most likely be C:/Program Files/Bend-Tech DesignTransfer.
7. Go into the Script folder, and select DesignTransfer.py
8. Do the same for Small Icon, selecting Icon1.png.
9. Do again for Large Icon, selecting Icon2.png.

10.Click OK, and then Close.
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11. Next to the Launcher Manager button, click on the drop down, and locate Parametric
Launchers. A Design Transfer Button should be listed. Place this button in a convenient

spot.

& Modeling - SDS/2 2020 Detailing -- v2020.04 (2) DESKTOP-AQLKBLM/20288
Utility Interface Options  Help

File Edit WYiew Mavigate

',/: Y @1@

Model Locate Process Reports

Elevation:
-21-89/16

I
@ fﬁ"/_ @ HIH-‘-, Defautt V] ﬁ

m' Command Group:

File

&

Il
v

Reports -- BIM

- Reports -- BIMJoist
i Reports -- Checker

Reports -- Detailing
Reports -- Drafting
Reports -- Engineering

=|Reports -- Erector
=Reports -- Fabricating

Reports -- Misc
Reports -- Madeling
Reports -- 5052_User
Reports -- Viewer
Interface

Opticns

Options -- Job Options
Optiens -- Fabricator Options
Optiens -- Plugins
Options -- Concrete Options
Miscellaneous
Decorations

User Modes

Selection

Selection -- Approval
Selection -- BIM
Selection -- BIMJoist
Selection -- Checker
Selection -- Detailing
Selection -- Drafting
Selection -- Engineering
Selection -- Erector
Selection -- Fabricating
Selection -- Misc
Selection -- Modeling

Parametric Launchers Iv

12.Click OK

=

%

=]

[}

[ ]

o) ! !
@

g

=g

temssdeceso ) EIEO Whro Dssomafemt  Joiffigl v

Launcher manager | Search:

Save Area
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Clear Mode Stack

Maode Return

Exit

B~
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